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Introduction 

During the last years several European countries have been experiencing an increased influx of 

refugees, mainly children, and a significant amount of effort has been devoted to the integration of 

those children in the host countries’ education systems. Nonetheless, relevant data show that 

students with a migrant background across the European Union have lower educational performance 

and are more likely to leave school earlier than native ones. Provided that refugee children do not 

commonly speak the host country language and most have been out of school for a significant amount 

of time, specialised knowledge and teaching skills are required of teachers so as to provide educational 

support to this vulnerable population. Teachers’ training is essential in order for them to meet the 

needs of migrant pupils, in particular of those in secondary education whose needs are increased, 

improve their school performance and prevent them from dropping out of school.  

HOPEFUL (Extending teacHers' cOmPetences in the effective teaching of numeracy, literacy and digital 

skills to rEFUgee chiLdren) aims to improve the performance of secondary school-aged refugee and/or 

migrant children who have remained outside the educational system for an extended period of time 

in numeracy, literacy and digital competences and to reduce refugee and/or migrant pupils’ early 

school leaving in Malta, Greece, Italy and Cyprus. In specific, the project aspires to enhance secondary 

school teachers’ aptitude in teaching numeracy, literacy and/or digital skills to refugee and/or migrant 

children with learning gaps due to interrupted education and with minimal native and/or English 

language skills through online training. Moreover, a key goal of HOPEFUL is the creation of an 

innovative diagnostic tool for the effective assessment of numeracy, literacy and digital competences, 

gaps and needs of refugee and/or migrant pupils.  

Since each country has a different education system, the exercises for assessing the aforementioned 

competences are not based on specific age clusters, but on two broader education stages of secondary 

education: Lower Post-Primary (typically covers ages 12 to 15) and Upper Post-Primary (typically 

covers ages 15 to 18). The present Booklet involves the diagnostic tool created for secondary school 

teachers to support them in accurately assessing the numeracy, literacy and digital competences, gaps 

and needs of Upper Post-Primary pupils with a refugee and/or migrant background. It is expected that 

the accurate diagnostic assessment will allow teachers to identify gaps and misconceptions, 

differentiate learning needs and make informed decisions so as to address the actual needs of the 

pupils and assist them in bridging the gaps caused by interrupted education, thus, reducing the 
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likelihood of early school leaving. The tool entails three main components and provides methods and 

practices for assessing:  

 Numeracy Competence: Algebraic, Statistical Skills  

 Literacy Competence: Reading Comprehension, Oral Language, Writing and Composition, 

Arguing/Reasoning, Critical Thinking  

 Digital Competence: Multimedia, Presentations and Tools, Spreadsheets, Networks and 

Security 

The accompanying Teachers’ Manual designed to supplement the present Booklet provides teachers 

with more information on the procedures to follow during testing, test time allocation, correct 

answers to the exercises, student performance descriptors, guidelines for scoring, evaluation and 

appropriate use of students’ results. 
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About me 

Dear student, 

This Booklet entails a number of exercises on the topics of Numeracy, Literacy and Digital skills. The 

aim of these exercises is to help your teachers understand your prior knowledge on these topics and 

prepare their learning material accordingly so as to better suit your learning needs. Your teachers 

will you give you instructions on how to complete the different exercises. But before you start, let’s 

learn a little more about you! 

First Name                                                                                 What is your favourite subject?                             

-------------------------------------------------------                          -------------------------------------------------------                       

Last Name                                                                                 What would you like to learn more about?               

-------------------------------------------------------                          -------------------------------------------------------                       

Age                                                                                              What do you want to be when you grow up? 

-------------------------------------------------------                           ------------------------------------------------------- 

Country 

------------------------------------------------------- 

Language 

------------------------------------------------------- 

Other Languages 

------------------------------------------------------- 

Have you attended school before? For how long? 

------------------------------------------------------- 



 

7 
 

Diagnostic Tool 
Upper Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

1. Numeracy Competence 

The first chapter of this booklet features exercises on the following 2 topics of Numeracy 

Competence: 

1.1. Algebra 

1.1.1. Basic Calculations 

1.1.2. Square Numbers, Roots and Powers 

1.1.3. Radicals and Surds 

1.1.4. Proportionality 

1.1.4.1. Direct Proportionality 

1.1.4.2. Inverse Proportionality 

1.1.4.3. Representations of Direct and Inverse Proportions 

1.1.5. Linear Models 

1.1.5.1. Functions and Relations 

1.1.5.2. Variables and Parameters 

1.1.5.3. Linear Graphs 

1.1.6. Linear Equations 

1.1.6.1. Simultaneous Equation 

1.1.7. Polynomials 

1.1.7.1. Polynomial expressions 

1.1.7.2. Quadratic expressions 

1.2. Statistics and Probability 

1.2.1. Data Collection 

1.2.1.1. Level of Measurement: Nominal, Ordinal, Interval or Ratio 

1.2.1.2. Organize Data: Absolute, Relative and Cumulative Frequencies, Frequency 

Table 

1.2.2. Data Set Characteristics 

1.2.2.1. Mode, Mean, Median, Quartiles, Measure of Center, Measure of Spread 
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1.2.3. Graphical Representation of Data 

1.2.3.1. Graphical Representations, Pie Chart, Bar Chart, Comparing Two Sets of Data 

1.2.4. Probability   

1.2.4.1. Sample Space 

1.2.4.2. Concept of Complementary, Independent, Mutually Exclusive and Exhaustive 

Events 

1.2.4.3. Venn Diagram 

1.1. Algebra 

1.1.1. Basic Calculations 

1. a. Solve the following equation: 

 

5 (- 3 x - 2) - (x - 3) = - 4 (4 x + 5) + 13 

 

     b. Simplify the following equation:  

 

2(a -3) + 4b - 2(a -b -3) + 5 

 

2. Solve the following:  

a. 0,06x+0,02 = 0,25x-1,5 

b. 0,65k-0,1 = 0,4k-0,35 

3. Find the LCD of 5/6 and 1/4   
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1.1.2. Square Numbers, Roots and Powers 

1. Solve the following: 

a. 36 

b. 256 π.Χ. 

c. 25 

d. 144 π.Χ. 

e. 94 

f. 704 

2. Find the value of the following powers: 

a. 104 

b. 1.010 

c. 1015 

d. 101 

1.1.3. Radicals and Surds  

1. Simplify the following expressions: 

a. √ 400 × √ 90 

b. √ 40 × √ 200 ( 

c. 90 × √ 600000  

d. √ 1000 / √ 40  

e. (1 - √ 5)(1 + √ 5)  

f. ( √ 7 + 3) ( √ 7 - 3) 

2. Rationalize the following expressions: 

a. 1 √ 5 - √ 3  

b. √ 11  

c. 30/ √ 3  

d. 1/(1 - √ 3)  
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e. 1/( √ 7 + √ 2)  

f. 2/( √ 5 - √ 7) 

1.1.4. Proportionality 

1.1.4.1. Direct Proportionality 

1. Given the pairs of numbers, answer to the following questions: 

Χ 2 1 6 7 8 

Y 14 21 42 49 56 π.Χ. 

(Πηγή: Esercizi sulle grandezze direttamente proporzionali (impariamoinsieme.com)) 

 

1.1. Which kind of proportionality these pair of numbers represent? 

a. Inverse 

b. Direct 

1.2. Which, among the following, represents the right equation? 

a. y= 7x                                                                       

b. y=9x 

c. y=5x 

d. y=4x 

 

2. Given the pairs of numbers, answer to the following questions: 

Χ 1 7 8 10 11 

Y 27 63 72 90 99 

 

2.1. Which kind of proportionality these pair of numbers represent?   

a. Inverse 

b. Direct 

 

 

 

https://www.impariamoinsieme.com/esercizi-sulle-grandezze-direttamente-proporzionali/
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2.2. Which, among the following, represents the right equation? 

a. Y=8x                                                         

b. Y=7x 

c. Y=10x                                                           

d. Y=9x 

 

3. Given the following X values, write the Y in the chart 

Y=6x 

Χ 7 2 13 29  4 

Y      

1.1.4.2. Inverse Proportionality 

4. Given the pairs of numbers, answer to the following questions: 

Χ 2 1 4 6 8 

Y 24 48 12 8 6 

 

4.1. Which kind of proportions are these pairs of numbers representing? 

a. Direct      

b. Inverse 

4.2. Which, among the following, is the right equation? 

a. y= 48/x      

b. y=28/x 

c. y=7/x    

d. y=11/x     
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5. Given these pairs of numbers, choose the right equation: 

Χ 2 1 8 4 5 

Y 60 120 π.Χ. 15 30 24 

 

a. Y=160/x         

b. y=80/x 

c. y=120/x                     

d. y=60/x 

 

6. Given the following X value, write the Y in the chart 

Y=x/150 

Χ 1 2 1 5 10 15 

Y       
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1.1.4.3. Representations of Direct and Inverse Proportions 

7. Which proportion does the graph below represent? 

a. Direct                 

b. Inverse 

 

 

 

 

 

 

 

 

 

(Source: internal) 

 

8. Which proportion does the graph below represent? 

a. Direct 

b. Inverse 

 

 
(Source: direct-and-inverse-ratio.png (750×350) (byjus.com) 
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Serie 1

https://cdn1.byjus.com/wp-content/uploads/2019/09/direct-and-inverse-proportion.png
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1.1.5. Linear Models 

1.1.5.1 Functions and Relations 

1. Given the graph represented in the image below, answer to the following questions:   

 

 

 

 

 

 

(Source: Questions on Functions with Solutions (analyzemath.com) 

 

1.1. . Is the graphs a function? 

a. Yes 

b. No 

 

1.2. Write the correct equation that correspond to the graph:  

 

2. Given the image below, answer the following questions: 

 

 

 

 

 

 

 

(Source: funzione pari e funzione | mathnotes ) 

2.1. Is the equation a function? 

a. Ναι 

b. Όχι 

 

2.2. Write the correct equation:   

https://www.analyzemath.com/calculus_questions/analytical/functions.html
http://www.mathnotes.it/funzione-reale-di-variabile-reale/funzione-pari-e-dispari/
http://www.mathnotes.it/funzione-reale-di-variabile-reale/funzione-pari-e-dispari/
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1.1.5.2. Variables and Parameters 

3State whether the following statements are true or false: 

 

3.1. 12 is a constant and z is a variable but 12z is variable.  

a. True 

b. False 

 

3.2.  7 is constant and p is variable but together 7 + p is a variable. 

a. True  

b. False 

 

3.3. 13 is constant and m is variable but together 13 - m is a constant. 

a. True 

b. False 

 

3.4. 11 is constant and n is variable but together 11 n is a constant. 

a. True 

b. False 

 

3.5. 0 is a variable. 

a. True 

b. False 

 

3.6. Combination of both a constant and a variable is also variable. 

a. True 

b. False 

 

3.7. A quantity which takes a fix numerical value is called variable. 

a. True 

b. False 
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3.8. A quantity or symbol which has a no fixed value but it can represent any numerical values 

is called variable. 

a. True 

b. False 

 

3.9. 15x, z/3, 7/m are some of the examples of constants. 

a. True 

b. False 

 

3.10.  x, a + b, c – 2, a 13 are some of the examples of variables. 

a. True 

b. False 

(Source: Worksheet on Constants and Variables | Constants and Variables | Answers (math-only-math.com)  

1.1.5.3. Linear Graphs 

4. Write the Cartesian coordinates of each point shown in the following graph (write the correct 

answer) 

 

4.1. 

 

 

Α: (_;_)  

Β: (_;_) 

 

 

 

 

 

 

 

 

 

 

B

A

0
1
2
3
4
5
6

0 1 2 3 4

Y

X

https://www.math-only-math.com/worksheet-on-constants-and-variables.html


 

17 
 

Diagnostic Tool 
Upper Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

4.2. 

    Α: (_;_) 

(Source: internal) 

 

1.1.6. Linear Equations 

1.1.6.1. Simultaneous Equation 

1. Solve the following systems of simultaneous equations (write the right answer) 

1.1. 

a. 2y+3x=6                           

b. Y=4x-2        

x= 

y= 

1.2. 

a. 3x+4y=12                         

b. 2x-3y=8                   

x= 

y= 

1.3. 

a. 3x-2y+3z=-16                 

b. X+2y-z=6                       

c. 2x-y+3z=-13         

 

A

0

0.2

0.4

0.6

0.8

1

0 0.5 1 1.5

Y

Asse X
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x= 

y= 

z= 

1.4. 

a. x+4=15                                                    

b. x-2y=12                 

x= 

y=         

(Source: BestMath) 

 

1.1.7. Polynomials 

1.1.7.1. Polynomial expressions 

1. Which polynomials are in a standard form?  

a. 𝑡𝑡4-1 

b. 2t2+3t+4 

c. 4t-7 

d. None of the above 

 

2. Which of the following expressions is not a polynomial? 

a. X3-4x2+5√𝑥𝑥+1 

b. X3-5x2 +2 

c. X2+4 

d. X 

(Source: Polynomials intro (practice) | Khan Academy) 

 

3. Write the degree of each of the following polynomial expressions in the following table: 

a. 5𝑥𝑥4+11𝑥𝑥3+2𝑥𝑥 +1  

b. √5𝑥𝑥2+1
6
𝑥𝑥3−1

5
𝑥𝑥+7  

http://bestmaths.net/online/index.php/year-levels/year-12/year-12-topic-list/simultaneous-equations/answers/
https://www.khanacademy.org/math/algebra/x2f8bb11595b61c86:quadratics-multiplying-factoring/x2f8bb11595b61c86:multiply-monomial-polynomial/e/polynomials-intro
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c.𝑥𝑥9+3
7
𝑥𝑥7+6𝑥𝑥  

d. 5y+8  

e. 3  

(Source: Polynomial Expressions | Basics & Definition | Solved Examples - Cuemath) 

 

1.1.7.2. Quadratic expressions 

4. Factorize the quadratic expressions and write the results: 

a. 𝑥𝑥2+4x+3=   

b. 𝑥𝑥2-7x+12=  

c. 𝑥𝑥2-2x-8=   

d. 𝑥𝑥2+x-2=  

e. 6𝑥𝑥2-7x-20=  

f. 12𝑥𝑥2-x-6=  

g. 𝑥𝑥2-25=  

h. 𝑥𝑥2-6x+9=  

i. 𝑥𝑥2+2ax+a2=  

j. 4x2-4x+1=  

(Source: 07-QuadraticEquations.pdf (une.edu.au) ) 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.cuemath.com/algebra/polynomial-expressions/
https://www.une.edu.au/__data/assets/pdf_file/0004/10876/07-QuadraticEquations.pdf
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1.2. Statistics and Probability 

1.2.1. Data Collection 

1.2.1.1. Level of Measurement: Nominal, Ordinal, Interval or Ratio 

1. Write the right option choosing among: Nominal, Ordinal, Interval or Ratio. 

a. High school men soccer players classified by their athletic ability: Superior, Average, Above 

average. 

b. Baking temperatures for various main dishes: 350, 400, 325, 250, 300 

c. The colours of crayons in a 24-crayon box. 

d. Social security numbers. 

e. Incomes measured in dollars 

f. A satisfaction survey of a social website by number: 1 very satisfied, 2 somewhat satisfied, 

3 not satisfied. 

g. Political outlook: extreme left, left-of-center, right-of-center, extreme right. 

h. Time of day on an analog watch. 

i. The distance in miles to the closest grocery store. 

j. The dates 1066, 1492, 1644, 1947, 1944. 

k. The heights of 21 65 year-old women. 

l. Common letter grades A, B, C, D, F. 

(Source: Solved: What type of measure scale is being used? Nominal, ordi... | Chegg.com) 

 

Given the following data, answer the questions:  

Day Celsius  Fahrenheit 

1 6 42.8 

2 9 48.2 

3 15 59 

 

 

https://www.chegg.com/homework-help/type-measure-scale-used-nominal-ordinal-interval-ratio-high-chapter-1-problem-39p-solution-9781938168208-exc
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2.1. The data collection is measurable by nominal or ordinal scale? 

a. Nominal 

b. Ordinal  

 

2.2. The data collection is an interval or report scale?  

a. Interval 

b. Report scale 

 

1.2.1.2. Organize Data: Absolute, Relative and Cumulative Frequencies, Frequency Table 

3. Given the following data collection: 

5 6 3 4 7 

2 0 3 3 4 

5 1 3 4 3 

 

3.1. Complete the frequency table: 

 

Number Frequency   

a. 0  

b. 1  

c. 2  

d. 3  

e. 4  
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f. 5  

g. 6  

h. 7  

i. Total  

 

3.2. Calculate the relative frequency of 0 (write the correct answer): 

 

3.3. Calculate the relative cumulative frequency of 1 (write the correct answer): 

 

1.2.2. Data Set Characteristics 

1.2.2.1. Mode, Mean, Median, Quartiles, Measure of Center, Measure of Spread 

1. Given the following data set: 

Player Height 

Player 1 1,96 

Player2 1,97 

Player 3 1,98 

Player 4 2,01 

Player 5 2,01 

 

1.1. Calculate the median (write the correct answer): 

 

1.2. Calculate the mode (write the correct answer): 
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1.3. Calculate the quartiles (write the correct answer): 

 

2. Given the data set 1,1,2,3,5,81,1,2,3,5,8 – answer the following questions: 

 

2.1. What is the range?  

 

2.2. What is the variance?                                            

 

(Source: Exercises - Measures of Center and Spread (emory.edu)) 

 

1.2.3. Graphical Representation of Data 

1.2.3.1. Graphical Representations, Pie Chart, Bar Chart, Comparing Two Sets of Data 
 

1. Given the data set and the pie chart below, answer to the following questions: 

Team basket 1 

Player Height 

1 1,96 

2 1,97 

1 1,98 

4 2,01 

 5 2,01 

 

 

 

http://mathcenter.oxford.emory.edu/site/math117/probSetMeasuresOfCenterAndSpread/


 

24 
 

Diagnostic Tool 
Upper Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

Team basket 2 

Player Height 

1 1,56 

2 1,59 

1 1,60 

4 1,62 

5 1,75 

(Source: internal) 

1.1. Which is the tallest team? (Write the correct answer) 
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2. .Given the bar chart below, answer the following question: 

 

(Source: Internal) 

2.1. Which player of each team is the tallest? 

Team 1: 

Team 2:  

 

3. The following bar chart is a representation of the age of the students in a specific school. 

Answer the following question:  

 

(Source: internal) 

 

 

 



 

26 
 

Diagnostic Tool 
Upper Post Primary 

The European Commission's support for the production of this publication 
does not constitute an endorsement of the contents, which reflect the views 
only of the authors, and the Commission cannot be held responsible for any 
use which may be made of the information contained therein. 

3.1. How many students does the school have? 

a. 100   

b. 110  

c. 90             

d. 12 

1.2.4. Probability 

1.2.4.1. Sample Space 

1. What is the sample space for choosing an odd number from 1 to 11 at random? 

a. 1,2,3,4,5,6,7,8,9,10,11 

b. {1,2,3,4,5,6,7,8,9,10,11} 

c. 1,3,4,7,9,11} 

d. None of the above 

 

2. What is the sample space for choosing a prime number less than 15 at random? 

a. {2,3,5,7,11,13,15 

b. {2,3,5,7,11,13} 

c. {2,3,5,7,9,11,13} 

d. All of the above 

 

3. What is the sample space for choosing 1 jelly bean at random from a jar containing 5 red, 7 blue 

and 2 green jelly beans? 

a. 5 red, 7 blue, 2 green 

b. Red, blue, green 

c. None of the above 

       

4. What is the sample space for choosing 1 letter at random from 5 vowels? 

a. {a, e, I, o, u} 

b. {v, o, w, e, l} 

c. {1, 2, 3, 4, 5} 

d. None of the above 
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(Source: Sample Spaces | Math Goodies) 

1.2.4.2. Concept of Complementary, Independent, Mutually Exclusive and Exhaustive Events 

5. What are mutually exclusive events? 

a. Events that add up at 100% Events that can happen at the same time 

b. Events that cannot happen at the same time 

 

6. Tossing a coin and landing on head and tails 

a. Mutually exclusive 

b. Not mutually exclusive 

 

7. Rolling a 6 or an even number 

a. Mutually exclusive 

b. Not mutually exclusive 

 

8. Drawing a red or an ace from a deck of cards 

a. Mutually exclusive 

b. Not mutually exclusive 

(Source: Mutually exclusive and complementary events (Only) - Quizizz) 

9. Write the correct answer to the following questions: 

9.1. There are 26 tiles of which 5 represent vowels in a game of scrabble. Two tiles are 

drawn so that the first is replaced before the second is drawn. What is the probability of 

not getting a consonant both the times? 

 9.2. A selection of balls numbered 1 to 10 is in a bucket. What is the complement to select 

a ball having number multiple of 3? 

9.3. Drawing a king and drawing a spade from a standard deck of cards. Are these events 

mutually exclusive? (Type yes or no) 

https://www.mathgoodies.com/lessons/vol6/sample_spaces
https://quizizz.com/admin/quiz/5ccac765ec94c0001fe6e520/mutually-exclusive-and-complementary-events-only
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9.4. A spinner has the six letters F, I, G, U, R and E written on each of its six equal 

segments. Tom tosses a coin and spins the spinner. Are these two events dependent or 

independent? 

9.5. There are 3 pens and 5 pencils in a box. If a student selects two of them at random, 

what is the probability of selecting a pencil and then a pen?  

(Source: Math Worksheets Center - Worksheet Viewer Page) 

1.2.4.3. Venn Diagram 

10. Out of forty students, 14 are taking English Composition and 29 are taking Chemistry. Answer 

the following questions: 

 

10.1. If five students are in both classes, how many students are in neither class? 

a. 2 

b. 1 

c. 3 

 

10.2. How many are in either class? 

a. 40 

b. 41 

c. 38 

 

10.3. What is the probability that a randomly-chosen student from this group is taking only 

the Chemistry class? 

a. 70% 

b. 60% 

c. 65% 

(Source: Venn Diagrams: Exercises | Purplemath) 

 

https://www.mathworksheetscenter.com/mathworksheets/MutuallyExclusiveIndependentComplement912inpract2.html
https://www.purplemath.com/modules/venndiag4.htm
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2. Literacy Competence 

The second chapter of this booklet features exercises on the following 5 topics of Literacy 

Competence: 

2.1. Reading 

2.2. Oral  

2.3. Writing 

2.4. Arguing/Reasoning 

2.5. Critical Thinking 

2.1. Reading 

1. Text Α: Racism in the school environment - Implications and ways of handling by parents1 

 

Definition of racism: Racism is not a new phenomenon. On the contrary, from the very first societies 

[…] people were divided into groups and distinguished between their "own" people and "others" […]. 

Especially in today's society where people of many different nationalities, economic migrants, 

refugees, the disabled, the mentally ill, etc. coexist, the cases of racism and unequal treatment run 

rampant. The diversity of a group leads it to form a distinct category, which is, in turn, forced into a 

submissive lifestyle, as it is most often accused of an alleged inferiority or danger. Therefore, we could 

summarize that the term racism refers to actions, behaviours and motives (intentional or not) on the 

part of a group of people against those who are "different". 

Racism in the school environment: […] In all public schools in Greece there are children who are 

"different" in terms of language, morals and customs, values and ideas, special abilities, learning 

difficulties, learning performance etc. These are the children who are mainly victimized with direct or 

indirect racism and marginalization. In many cases, racism is expressed through physical violence, 

threats, abusive comments or verbal violence. We have all, more or less, been victims, perpetrators, 

or simply observers of school racism at least once in our lives, while it is an indisputable fact that 

racism, in whatever form it takes, harms psychologically and with no exception, perpetrator, victim, 

witness and society as a whole. In the case of the victim, there is intense discomfort, stress, and 

 
1 https://www.rhodes.gr/arthro-evesthitopiisis-kk-me-parartima-roma-ratsismos-sto-scholiko-perivallon/ 

 

https://www.rhodes.gr/arthro-evesthitopiisis-kk-me-parartima-roma-ratsismos-sto-scholiko-perivallon/
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feelings of inferiority which have devastating consequences for individuals as well as for their family 

and school environment. 

Impact of racism on the school environment: The psychological and social consequences of racism 

are innumerable and they affect all sides with no exception. Typically, regarding the school 

environment: 

 The child – victim of racism experiences mockery, ridicule, insecurity and professional 

exclusion later on, as there are many cases of school dropout and incomplete schooling by 

the child who suffers from racism 

 The child – victim turns in upon itself and becomes suspicious and introverted, thus losing 

the sense of self-esteem […] 

 […] Violence, crime and school bullying are promoted 

 […] In many cases, racism breeds racism and the use of violence leads to the reaction and 

delinquent behaviour on the part of the child who was originally a victim of school racism, 

thus creating a vicious cycle of violence and delinquency. 

[…] The phenomenon of school racism is unfortunately rampant in today's society. Ways to prevent 

and/or treat it exist and are possible on the part of the parents. There is a way for everything as long 

as they are possessed by love, empathy, compromise and tolerance towards each of their fellow 

human beings. Remember Nelson Mandela's words about racism: “No one is born hating another 

person because of the colour of his skin, or his background, or his religion. People must learn to hate, 

and if they can learn to hate, they can be taught to love, for love comes more naturally to the human 

heart than its opposite”. 

 

1. After reading the text, make a short summary in 100 words.  

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________
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__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

 

2. . “No one is born hating another person because of the colour of his skin, or his background, or 

his religion. People must learn to hate, and if they can learn to hate, they can be taught to love, for 

love comes more naturally to the human heart than its opposite”. 

How do you understand the previous quote by Nelson Mandela? 

 

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

 

3. Find synonyms for the following words: 

a. Coexist -------------------------------------------------------- 

b. Treatment -------------------------------------------------------- 

c. Ideas -------------------------------------------------------- 

d. Devastating -------------------------------------------------------- 

e. Possessed -------------------------------------------------------- 
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4. Find antonyms for the following words: 

a. Divided -------------------------------------------------------- 

b. Marginalization -------------------------------------------------------- 

c. Suspicious -------------------------------------------------------- 

d. Rampant -------------------------------------------------------- 

e. Tolerance -------------------------------------------------------- 

5. According to the text racism “harms psychologically and with no exception, perpetrator, victim, 

witness and society as a whole”.  

Briefly describe what you consider to be the consequences of racism for perpetrators, victims, 

witnesses and society.  

Perpetrators Victims Witnesses Society 
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2. Text Β: Culture and opportunities in the COVID-19 era2 

[…] For a long time now, a museum, a gallery, or a theatre have ceased to be places we just go to so 

as to individually browse exhibits or attend performances. Now they are raised to places of meeting, 

socialising, searching and tranquillity. In the "COVID-19 era" many of them started to become digital. 

Culture is another area that has been affected by the pandemic, and is even called upon to face the 

greatest challenges. At this time, therefore, it is particularly important to reflect on the role of culture, 

as a branch of creative economy that contributes to the development of the economy and society, 

and its importance for our country. 

Creative economy is not easy to define, as it is not a static concept. According to the definition given 

at the United Nations Conference on Trade and Development, it is "an ever-evolving concept based 

on the interaction between human creativity, ideas, intellectual property, knowledge and 

technology." Creative economy can contribute very positively to the development of an area, 

especially in countries like Greece, a place with a rich history in cultural tourism. In specific, its capital, 

Athens, has some characteristics, which place it in a very "competitive" position in the cultural field, 

so that the role of its creative economy becomes even more central – especially in an era like the one 

of COVID -19. 

[…] Undoubtedly, the "COVID-19 era" accelerated and expanded the use of technology in civilization. 

At the beginning of the crisis, all museums and cultural sites began to present their content for free, 

but this fact, combined with the fact that actual premises remained closed for a long time, led to a 

significant reduction in their revenue. Digitization is now part of the presence of a cultural space and 

the next step is to find ways for these actions to become financially beneficial and profitable parallel 

sources of revenue. As the president of the Museum of Cycladic Art, Ms. Sandra Marinopoulou, has 

pointed out, if the level of digital experiences created is high-quality, then an archaeological site, a 

museum, a festival and any other cultural institution can set an affordable price for its audience and 

proceed to their creation. In this way, organizers will no longer be limited by the capacity of actual 

facilities, while spectators, accordingly, will not be bound by their place of residence. So suddenly, one 

can get an audience of people living in every corner of the globe with internet access as the only 

prerequisite. Also, a highly digital traveller has the ability to visit many more places in less time.  

 
2 https://higgs3.org/politismos-efkeries/ 

 

https://higgs3.org/politismos-efkeries/
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If used properly, such solutions can bring new opportunities and additional sources of income in our 

country. Of course, intellectual property issues will come up and we will need to learn new 

professional skills. However, if there is careful planning and an appropriate legal framework, so that 

we can take advantage of the new trends and opportunities that arise, the result will be positive and 

particularly creative. 

1. After reading the text, circle whether the following sentences are True (F) or False (F).  

1. In the COVID-19 era museums, galleries, etc. necessarily ceased to be a meeting place. T       

F 

2. Creative economy is a fluid concept. T       F 

3. Digitization can be profitable for cultural venues. T       F 

4. Internet access is one of the many requirements that one needs to meet in order to engage 

in digital experiences of visiting cultural sites. T       F  

2. Provide a brief summary of the third paragraph of the text. 

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 
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3. “Of course, intellectual property issues will come up and we will need to learn new professional 

skills”.  

a. What kind of intellectual property issues can occur from the digitization of cultural 

sites?  

b. What new skills will professionals in the field need to develop? 

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

 

4. Find synonyms for the following words: 

a. Reflect -------------------------------------------------------- 

b. Static -------------------------------------------------------- 

c. Led -------------------------------------------------------- 

d. Part -------------------------------------------------------- 

5. Find antonyms for the following words: 

a. Go to -------------------------------------------------------- 

b. Central -------------------------------------------------------- 

c. Accelerated -------------------------------------------------------- 

d. Opportunities -------------------------------------------------------- 
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6. What are the advantages and disadvantages of digitizing cultural sites based on the text? List 

them and add at least two ideas of your own on related pros and cons. 

 

Advantages Disadvantages 
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3. Text C: Multiculturalism, migration and education3 

The term multiculturalism denotes the coexistence in society of diverse social groups with different 

national-ethnic and cultural traits. It recognizes a mosaic of equal cultures of individuals who maintain 

their distinct differences and can develop fruitful relationships of interaction. At the level of social 

collectivism, multiculturalism refers to the mutual acceptance, respect and promotion of multiple 

cultures based on the demographic composition of a country's population. It expresses the acceptance 

of diversity and the equal recognition of distinct ethnic and religious groups. 

The causes that created the phenomenon of multicultural societies are numerous: 

 The escalation of economic and social problems in various countries has pushed many citizens 

to migrate and seek better living conditions in new places of residence. […] 

 Wars and civil conflicts that created a bleak reality and an uncertain future for peoples’ 

survival. 

 Violation of human rights by authoritarian regimes to the detriment of national and religious 

minorities. […] 

 The prosperity and progress of a country that functions as a pole of attraction for immigrants 

as they see in it incentives for creation and social development. 

The reactions initially created by multicultural coexistence were negative: 

 Migrant host countries, have faced various problems after their influx, due to lack of 

infrastructure. It was difficult to secure means of accommodation, professional career, health 

care, decent living. 

 Phenomena of exploitation, unequal treatment, prejudiced behaviour and discrimination 

against migrants were observed. 

 A climate of xenophobia and guardedness was cultivated as it was considered by some citizens 

that the increase in crime was linked to the influx of foreigners. 

 
3 http://www.koinosnous.com/home/ekthesi-ekfrasi/themata-ekthesis/polypolitismikotita-kai-ekpaideusi 

http://www.koinosnous.com/home/ekthesi-ekfrasi/themata-ekthesis/polypolitismikotita-kai-ekpaideusi
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 Feelings of insecurity, uncertainty, suspicion, questioning and underestimation of other 

people’s culture were created and those were treated as invaders and potential destroyers of 

the cultural identity of their host countries. 

 There was a tendency of introversion from citizens that led to the marginalization of foreigners 

and the disintegration of social cohesion. […] 

The school’s role in shaping a multicultural consciousness: 

 The school is called to respond to the new reality of multicultural societies, which is why it is 

necessary for education researchers and theorists in collaboration with teachers to create 

expanded curricula that will incorporate materials, ideas and values from a variety of cultures. 

[…] 

 As Hanley argued, "Multicultural education requires deep and critical thinking, imagination 

and commitment to create a tomorrow that encompasses the richness of all stories and all 

people. It is another aspect of the constant human journey to justice and pushes people to 

fulfil the promises of democracy". […] 
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1. What economic and social problems can lead a person to migrate? List them based on the text 

and incorporate as well some ideas of your own.  

a. --------------------------------------------------------------------------------------------------------------- 

b. --------------------------------------------------------------------------------------------------------------- 

c. --------------------------------------------------------------------------------------------------------------- 

d. --------------------------------------------------------------------------------------------------------------- 

e. --------------------------------------------------------------------------------------------------------------- 

f. --------------------------------------------------------------------------------------------------------------- 

g. --------------------------------------------------------------------------------------------------------------- 

h. --------------------------------------------------------------------------------------------------------------- 

2. People's reactions to cultural coexistence are often negative. How do you interpret such 

reactions? Where could they be due to?  

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

 

3."Multicultural education requires deep and critical thinking, imagination and commitment to 

create a tomorrow that encompasses the richness of all stories and all people. It is another aspect 

of the constant human journey to justice and pushes people to fulfil the promises of democracy".  

How do you understand the above phrase? 

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 
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4. What would be the benefits of multicultural coexistence for individuals and societies in your 

opinion? Write a relevant text of 100 words.  

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 

 

5. How could school contribute to the harmonious cultural coexistence of children from different 

cultures? Describe briefly.  

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________

__________________________________________________________________________________ 



 Diagnostic Tool 
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4. Text D: The nicknames 

Yiorgos Ioannou. (1982). The Sarcophagus, Prose. Athens: Kedros Editions, pp. 35-40 

I met an old classmate of mine on the street, now bald and almost old, who made horrible complaints to me 

for supposedly seeing him on the street and not greeting him. I listened to him for a while in silence and then 

I hurried to admit my guilt so as to get rid of him sooner rather than later. As we drifted apart, I inadvertently 

got to relive the past. My blood rushed. This monster who had the audacity to complain to me, was one of my 

biggest persecutors and torturers when we were together at school. He was the one mostly spreading my 

innumerable nicknames, imitating even the way I spoke as ridiculously as possible. The truth is: that he did 

not give me new nicknames because he was not able to do so, but he showed great zeal for the spread of the 

already known ones. It was also this orangutan who transferred the school nicknames to my neighbourhood 

and vice versa, and he and his company called them out loud to me even in the street when I went for a walk 

with my parents. This beast thinks that I do not remember them anymore or that I have a soul as thoughtless 

as his own. But does a sane person ever forget or forgive the tortures that were inflicted upon him? So how 

can I forget what I was going through since the first grade of elementary school? 

First things first, the other, my old last name, was a funny nickname. And there was no need for others to say 

it, I had to state it myself every now and then. When I was young, some people used to isolate me and make 

me repeat it, pretending that they did not hear it clearly. They died laughing each time. At school again, as I 

progressed grade levels, it became a torment. As soon as they started calling the (students’) list, my heart was 

pounding, my hands were sweating and I was trembling. In the meantime, the teacher had called my last name 

two or three times, until he heard the lifeless “present” I said, in a classroom bursting with laughter. Once 

upon a time, an awful music teacher, a big seed, interrupted (calling) the list, ordered me to get up, and turned 

to me: "Why aren't you shouting out loud, you dufus?" That's what the others wanted; he was throwing them 

new food. For a long time, among many others, I was the "dufus" of the class. The evilest ones tried in every 

way to make it known across the whole middle school. They even tried to narrate the incident, while I was 

somewhat near their company so that I could hear it too and burst […]. 

Fortunately, high school was located in a different district from the elementary school I graduated from, so 

the high school nicknames were not added to the elementary school ones. Because it was there that my soul 

had been scalded. Our teacher, an unspeakable ill-mannered old maid, as soon as she saw me wrinkled on the 

desk, noticed: "You, my child, do like a hedgehog". All the children laughed and from the very first break they 

started calling it at me. The teacher delightedly repeated it for the second hour. At first everyone called me by 

my nickname mockingly. Then, instead of forgetting it, they got used to it, and called it without any particular 
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malice, like (they would) any name. But it was impossible for me to get used to it, every day it hurt me more 

deeply. Especially when we were playing football and they wanted me to give them a pass, then "Hedgehog, 

Hedgehog" echoed in all tones. 

I started not to play with anyone. I was playing various games of my own in our yard. I found two nests of ants 

different in colour and size. Because I was very blond, I wanted one nest to have blond ants. The other had 

dark and large agile legs. They were not difficult to find. I would then take one of the blondes, which were 

weaker, and throw it into the hole of the nest, where the black ants were boiling. They immediately 

surrounded the blonde one, bit it from everywhere, pulled it, and finally, in a crowd, dragged it half-dead to 

their nest. "The hedgehog is gone," I said bitterly. […]. 

In the evenings, usually while we were eating, the children passed in groups under the house and yelled my 

various nicknames in the dark. They even made up songs for me. Only I listened to them, my own people did 

not have a clue. I then had a tight stomach, I was pale, and I ran to sleep or rather to hide under the mattresses 

leaving food in the middle […]. 

Now even my most bad-mouthed and bitter friends and colleagues do not dare to make up a nickname for 

me. The thing almost makes me sad. It seems that over time my voice, my shape, my thinking, my gait, finally 

got to suit me, maybe they were corrected, while at first, they were probably premature and out of place on 

me. But with most of them, the opposite happens. Of course, the fact that I have become an ace myself in 

sticking nicknames must have played some role and a few (nicknames) that I once sent registered to some 

scoundrels and ridiculous ones scalded them so much that they did not make a fuss again. Too bad I did not 

discover this method before. 

But whatever it is, I now understand how much I once suffered for nothing and how much of an impact those 

nicknames have had on my whole life. 
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1.What were the short-term and long-term consequences of the nicknames his classmates called him on 

the author on a physical, psychological, emotional and behavioural level?  

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 

 

2. What does the game described by the author in the fourth paragraph indicate? What is its deeper 

meaning?  

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 

 

3. The author describes two incidents with teachers whose attitude led his classmates to assign him more 

nicknames. How do you evaluate the attitude of the teachers of the text? 

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________
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________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 

 

4. “…I have become an ace myself in sticking nicknames … and a few (nicknames) that I once sent 

registered to some … scalded them so much that they did not make a fuss again”. 

How do you interpret this behaviour of the author in adulthood? 

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 

 

5. How could the author have been helped as a child so as to deal with the school bullying described in the 

text? Write a relevant text of 200 words.   

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 
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2.2. Oral 

1. The painter Mondrian spoke about the possible "disappearance" of art. He believes that reality will 

increasingly displace the work of art, which was mainly a substitute for a balance that is now missing from 

reality. "Art will disappear as life becomes more balanced" 

 

a. Do you agree with the position of Mondrian that art is a substitute for life? 

b. What are the necessary conditions "to be an artist"? 

c. What do you consider to be the starting point for creating a work of art? 

d. What themes in art do you consider to be timeless? 
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Composition with Large Red Plane, Yellow, Black, Gray, and Blue (1921) 4 

 

 

 

 

 

 

 
4 https://www.wikiart.org/en/piet-mondrian/composition-with-large-red-plane-yellow-black-gray-and-blue-1921,png 
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2. Watch this video and answer to the following questions:  

https://www.youtube.com/watch?v=2Yt6raj-S1M,png 

 

a. How could school make kids less intelligent? 

b. What are the different kinds of intelligence? 

c. Despite being a straight C student, Eddy started his own company which became extremely successful. 

How do you explain this? 

d. “Parents, teachers and educators can inspire youth”. In what ways? 

e. “No one has ever changed the world by doing what the world has told them to do”. Do you agree? 

Explain. 

 

3. Put the illustrations 5 in order to tell a story. Are there positive things that are happening in the world 

during the global pandemic? In which aspects of their life have the people started thinking differently? 

 

 

 

 
5 https://busyteacher.org/26270-caring-sharing.html,png 

https://www.youtube.com/watch?v=2Yt6raj-S1M
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2.3. Έκθεση 

1. Develop a speech that you are going to present in a school context with the topic: Describe how 

communication has changed in the last 20 years. (250-350 words) 

 

2. Write an article, which will be published on school newspaper. Mention:  

a. basic conditions for a civilized dialogue and  

b. activities that a school could organise, in order to enhance the dialogue capacity of school 

community members. (200-300 words) 

3. Suppose you are a computer programmer and a company offers you a remote working job. You are 

asked to reply to them with a letter explaining the reasons why you would not want to work as an 

employee in a company in this way exposing the negatives that you think are related to that company’s 

suggestion. (250-350 words) 
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2.4. Arguing/Reasoning 

1. Prepare an argumentation speech that you are going to deliver to your class. Ask him/her to select a 

topic among the below topics: 

 

a. Should what you say on facebook be grounds for getting fired? 

b. Is TV stronger than ever, or becoming obsolete? 

c. Why aren’t there more girls in leadership roles? 

d. What local problems do you think your mayor should try to solve? 

e. What can older people learn from your generations? 

 

2. Prepare an argumentation text in an article that will be published in the local newspaper about the 

following topic:  

“Human activity has had a negative impact on plants and animals around the world. Some people think 

that this cannot changed, while others believe actions can be taken to bring about a change”6. 

Discuss both and give your opinion. 

 

 

 

 

 

 

 

 
6 https://ieltsliz.com/100-ielts-essay-questions/environment/ 
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2.5. Critical Thinking 

1. In groups of 2, discuss with each other about advertisement-consumerism in nowadays. You have 10 

minutes to discuss this topic analysing the most important causes of consumerism and what are the 

consequences in relationships and societies. After your discussion, one student has to present the main 

points of the conversation 

 

2. Comment on the phrase "material goods are comforting substitutes for our real need for 

communication and meaningful contact" in a paragraph of 70-90 words. 

 

3. Watch the video and answer the following questions: 

https://www.youtube.com/watch?v=mzu3ira61k8 

 

a. “Maybe after we understand each other we can become friends instead of enemies”. Explain this phrase 

in your own words. 

b. “We are each a piece of puzzle in humanity”. How is that? 

c. “We should all be judged by our actions and characters”. Do you agree? 

d. How can people from different cultures learn to co-exist? Make suggestions. 

 

  

https://www.youtube.com/watch?v=mzu3ira61k8
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3.  Digital Competence 

The third and final chapter of this booklet features exercises on the following 4 topics of Digital Competence: 

3.1. Multimedia 

3.2. Presentations and Tools 

3.3. Spreadsheets 

3.4. Networks and Security 

3.1.  Multimedia 

 

1. Sound 

Computers until the end of the 1980s were not built to import and reproduce sound, since there was no 

suitable hardware and software for this purpose. Often there was a small built-in loudspeaker, which was 

suitable for low-quality sound. Computer sound processing systems were very specialized and expensive. Since 

the 1990s, cards began to spread extension for good quality audio input and playback, at affordable prices. 

With these possibilities and the great development of the Internet, which had begun at that time, new 

possibilities began to be offered to computer users. Today, we cannot conceive of a computer, small or large, 

that does not provide the user with a rich and high-quality multimedia experience 

2. Digital audio and sound digitization process 

In digitization, the sound from the microphone is converted into an electrical signal, which is channelled into 

an integrated circuit, the analogue to Digital Converter (ADC). This converter takes samples (measurements) 

of the sound at a certain rate, which is called the sampling rate, and we measure it in Hz. Each sample 

(measurement) is then converted into a corresponding digital number, which is represented as a series of bits 

(usually 8 or 16 bits).  

3. Video  

Computers today are largely used for video playback. Usually, in the video sense one perceives the 

cinematographic or other films that a person can see on the computer. In the category of video, however, 
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EXERCISES:  

1. Work in groups to apply everything you learned to create a small movie using sound and videos. 

 

  

cartoons and many games can be included, because their depiction has the same characteristics as those of 

films. Also, we should not forget that the computer can be used both for creation and for video editing. 

4. What are the features of a digital video? 

A video actually consists of several images of the same size, placed one after the other, which are presented 

at a fast enough pace, so that the eye (and the brain) creates the illusion of movement.  

The main features of a video are the following: 

 Frame size in pixels (in the language of video production each picture is called frame), for example 

640×480. 

 Colour depth (colour depth), i.e., how many bits each is composed of Pixel (for example: 4, 8, 24) 

of each frame. It is exactly corresponding to the colour depth we have already encountered for the 

pictures. 

 Frame rate, i.e., how many frames (images) are displayed sequentially each second. Measured in 

frames per second (fps), for example, 50 fps. It is corresponding to the sampling rate of sound. 

 Interlacing is a method used to double the frame rate, without doubling the information when 

sending the video. Because the eye is more sensitive to low frame rates (where the image seems 

to flicker) than to the detail of the image, only the odd rows of pixels of one frame and the even 

ones of the next are sent, so that when presented interchangeably the rate of rotation is faster 

and the image smoother. 
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3.2.  Presentations and Tools 

1. Introduction 

The presentations app allows us to create performances (presentations). Files that are presented using a 

presentation application deposit from one or more slides. In the slides we can insert text, tables, graphs, 

images, shapes, video, audio, etc. Commercial applications are Microsoft PowerPoint, LibreOffice Impress and 

Keynote. 

2. Creating a presentation 

Opening the PowerPoint presentations app creates a new presentation. If the application is already open and 

we want to create a new presentation, from the File tab we select New and then Blank presentation. The new 

presentation consists of a single slide, the title slide. 

3. Add New Slide  

From the Home tab and the Slides group we select the new Slide icon. 

4. Change Slide Layout 

For each new slide we must select the most appropriate layout, so that it contains the objects we desire. To 

change the layout, follow the following steps: 

• From the Home tab and the Slides group we select the Layout icon. 

• Then we select the desired layout for the slide us. 

 

5. Save presentation 

The default file format when we save is PowerPoint Presentation, which gives the extension .pptx on file. If we 

want to save our presentation with a different file type, we use the Save As file command and in Save As type: 

select the desired file type. 

Some useful file types are: 
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• Pptx presentation 

• PDF text files 

• Pptx slide show 

• Jpg images 

 

6. Change slide background  

To change the background of one or more slides: 

1. We choose slide or slides. 

2. From the Design tab and the Customize team we select the Background Format icon. 

3. from the Fill tab we select: 

 Solid fill:  If we want our slide to have colour. Then we choose the colour we want. 

 Gradient fill:  if we want to use colour scheme. Then we choose the combination we want. 

 Picture or texture fill:  if we want to use image or texture as background in the slide. Then 

we press Texture to select texture or File to select image 

 Pattern fill:  if we want to choose a pattern 

4. We select Close if the background we selected we want to apply only to selected slides or Apply 

to All if we want to apply to all slides. 

 

7. Apply design Themes as a background to slides 

Microsoft PowerPoint provides many design templates that you can apply to a presentation to give it a 

professional look with full design. 

To apply template: 

1. From the Design tab and the Themes group we select one of the available templates that exist. 

 

 

2. To apply the template to the selected slides, we right-click and select Apply to Selected Slides. 

3. To apply the template to all slides of the presentation, we right-click and select Apply to all Slides. 
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8. Insert text 

To be able to insert text into a slide we must first click on a Text Box in the slide, or create a text box. To create 

a text box from the Insert tab, select Text Box. Then we Type our text. 

9. Formatting text and paragraph 

In the text we can apply various font and paragraph formatting. Below we see the most basic. 

1. We select the text we are interested in. 

2. From the Home tab and the Font or Paragraph group we select one of the following icons: 
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Font 

 
Size 

 
Bold  

 
Italic  

 
Underline 

 
Text Shadow 

 
Distance between characters 

 
Alternation of characters (e.g., from Lowercase to 

 

 Change letter colour 

 

Dots  

 
Numbering  

  
Left align 

 
Center align 

 
Right align 

 
Fully align  

 
Line spacing (line spacing) 

 
Splitting the text box into columns 
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EXERCISES: 

1. Go to PowerPoint and follow steps 2 to 9 described above to familiarize yourself with Presentations and 

Tools. 
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3.3. Spreadsheets 

1. Main characteristics of a table 

A table consists of a set of cells arranged in columns and rows. 

2. Creating A Table 

From the Insert tab and the Tables group we select the table icon. Then we click on Insert Table command 

... and in the dialog box we specify number of columns (Number of columns) and rows (Number of columns 

rows), which we want to use. 

 

3. Format Table 

To display commands and format a table, the cursor must be inside the table. Then, the toolbar will display 

two more tabs on the ribbon with options a) table Design and B) Layout. From these two tabs can be made 

most of the formatting, relating to a table. 

 

1. Insert row and column: from the layout tab and the 

Command Group Rows and Columns we can insert a new line above or below the selected 

line. Accordingly, we can introduce a new one column right or 

left of the column we have selected.  
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2. Delete cells, row, column or whole table: from layout tab and command group Rows and 

Columns by selecting delete, we can delete the cell, row, 

column where it is located inside our runner. From here we 

can also delete the entire table.  

 

3. Change the row height and Column Width of the table: from the layout tab and cell Size 

command group we can adjust the row height and Column 

Width we have selected. 

 

4. Formatting the content of the table: formatting the content of a table is done in exactly the 

same way, as in the rest of the text that is outside the table, from the Home tab and the font 

command group. 

5. Contours and shadings: the process here too is the same as that done in the text, located 

outside the table. First, we select the cells on which we would like to apply shading or contour. 

Then, from the Home tab and the Paragraph group, we select the border icon if we want to 

apply a border, and the shadow icon if we want to apply a shadow. 

6. Merge cells: we select the cells we want to merge and from the Layout tab and the Merge 

Cells group we select the Merge Cells icon. 

 
7. Split cells: we select the cells we want to separate, and from the layout tab and the Merge 

group we select the split Cells icon. 

8. Automatic change in the style of the table: we select the table we want to from the table 

Design tab and The Table Styles group we select one of the icons with the ready formats, which 

we want to use. 

 
9. Changing the alignment and direction of text within a cell: We select the cells we want to 

change  their alignment and then from the layout tab and the align command group we select 
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the alignment that we wish. From this tab and with text 

option direction we can change the direction of text inside the 

cells. 

 

4. Sort items in one column of the table 

We select the column of the table that we want to sort, and then, from the layout tab and the data 

command group, we select the Sort. From the window that appears we 

can specify the content of if it is plain text, numbers or dates and if we 

want ascending or descending classification. 

 

 

 

 

 

EXERCISES:  

1. Go to Word, create a new document and insert a table. 
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3.4. Networks and Security 

1. Introduction  

Computer Network is a group of two or more computers or other devices, connected to each other for the 

purpose of exchanging data or sharing common peripheral devices (e.g., a printer in some office), files 

(e.g., patient file in a hospital) and software (e.g., customer service program in store). A network can only 

extend to one room, one building, to buildings within a few kilometres, within a city, between several 

cities, within a country or several countries. On the basis of the geographical area covered, the networks 

are classified into two categories: 

 Local Area Network-LAN: is a network within one or more rooms, a building or even between 

nearby buildings. It connects computers to a limited geographical area coverage zone. 

 Wide Area network - WAN networks: usually, they connect several local networks together 

and cover a large (wide) geographical area. Public telecommunications lines or, sometimes, 

satellite telecommunications are almost always used for this interconnection. These networks 

may extend within a city, between cities of a country or in cities of different countries. 

 

2. Networking devices 

To create a network of computers and other devices, special networking equipment is needed, as shown 

below: 

 Network Interface Card, NIC:  Device that is usually installed inside the computer and connects 

the computer to a computer network. The connection can be made by wire or wirelessly 

 Switch:  Device with multiple ports (16-ports, 24-ports) that connects computers and devices, 

one/one to each port, using cables and allowing them to exchange information to form a 

network. The corresponding device for connecting to a wireless network is called a wireless 

access point 

 Router:  Device that connects a local network to the Internet or several networks together. It 

is responsible for routing (sending in the right direction) data along multiple networks 
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 Modem:  Device that connects the computer or other device to an analog telephone line. Its 

purpose is to convert the digital signal (information) of the computer to analog and vice versa 

(Modulation/Demodulation), so that it can be transferred via an analog telephone line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Network and Internet risks, security and protection measures 

It is often stated that the use of networks poses risks to the user and computers/devices. Here, we will 

consider, mainly, the risks associated with problems of the device, but for which protection measures can 

be taken with settings or software installation.  

4. Protection of wireless networks 

With the widespread use of wireless networks, the need to protect the wireless network and the data 

transferred from it arises. Many times, non-qualified personnel purchase and install wireless equipment 

(router or wireless access point). Once the equipment is installed, it is set by its manufacturer with 

standard values. These are known to anyone and can easily connect to our wireless network, either to gain 

access or to intercept our data. For this reason, we must adjust the equipment at least by specifying the 

following settings with values of our own choice: 
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 The password (password) of the administrator (administrator) of the equipment. 

 The name of the wireless network (SSID). 

 Wireless network security settings. Avoid the WEP encryption / certification which does not 

provide much security and prefer WPA2. Also, we make sure the key phrase (passphrase/key) 

is difficult to be discovered using at least 8 characters, uppercase and small letters, numbers 

and symbols. 

 Disable SSID Broadcast. This has as result that our network is not located in the available 

wireless networks and only those who know its name can connect 

 

5. Updating the operating system and applications 

Often, security gaps and other problems are found in both the operating system and applications, in 

particular web browsers (Internet Explorer, Firefox, Chrome, Opera, Safari, etc.) Systematic and frequent 

updating is recommended for both the operating system and these programs, so the exploitation of 

security gaps by intruders in the system and malicious programs is prevented. 

6. Firewall Installation 

Firewall is software (program) or material (device), which is accordingly configured, so to allow or reject 

data packets that they pass from one computer network to another. Firewall protection may prove useless 

if not configured right. 

To enable /disable the Windows Firewall, we can to follow the following steps: 

 We activate the Control Panel. 

 Click on Network and Internet. 

 Click on Network and Sharing Center. 

 Click on Windows Firewall. 

 Click on Turn Windows Firewall on or off. 

 In the framework below we make the appropriate choices. 

 Click OK 
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7. How to create a strong and secure password: 

According to traditional advice a strong password: 

 It has 12 characters, Min: You must choose a password that is long enough. There is no 

minimum password length that everyone agrees on, but generally you should choose 

passwords that are at least 12 to 14 characters long. A longer password would be even better. 

 Includes numbers, symbols, uppercase and lowercase letters: Use a mix of different character 

types to make the password harder to crack. 

 It's anything but a word reference word or a mix of word reference words: Stay away from 

clear word reference words and word reference word blends. Any word without anyone else 

is awful. Any mix of a couple of words, particularly in the event that it is self-evident, is likewise 

terrible. 

 Doesn't Rely on Obvious Substitutions: Don't utilize normal replacements, either — for 

instance, "H0use" isn't solid since you've supplanted an o with a 0. That is simply self-evident. 

Attempt to blend it up—for instance, "BigHouse$123" fits a significant number of the prerequisites here. 

It's 12 characters and incorporates capitalized letters, lower-case letters, an image, and a few numbers. Be 

that as it may, it's genuinely self-evident—it's a word reference express where each word is promoted 

appropriately. There's just a solitary image, every one of the numbers are toward the end, and they're in 

a simple request to figure. 
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EXERCISES:  

1. Answer the following questions: 

a. What is networking? 

b. Define Network devices. 

c. Differentiate between LAN and WAN. 

d. Define a peer-to-peer network. 

e. What is communication medium? 

2. Go ahead and create your own password. How would you be able to deal with limiting the dangers to 

your remote organization? Make a list.  
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Teacher Comments and Observations  
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